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Why doesn't the smart album show the number of pictures ?Would be really handy. Hi Daphne! Thanks for the feedback. Please, submit a request through our support page, and we will forward your suggestion to our Product Team: https://
support.captureone.com/hc/en-us/requests/new?ticket_form_id=5001426573597

Hi David, thanks for doing the webinars. My question: Is it possible to exclude certain keywords during exporting like LR? If not, is there any workaround apart from 
creating many, many keyword lists which complicates things? Thanks a lot.

Hi Aoma, I don't think you have such an option, but you can create a Smart Album based on particular keywords and then export fro that Album. 
Thank you Helen. I was looking at an option to for example exclude people's names added in as keywords for search purposes, but want to exclude them during 
export for privacy reasons. From what I understood, this is not possible? Thanks again. 
Got it, but yeah, not yet. I'll make sure to share this as a feature request, thanks for the contribution. 
Thanks a lot.

Is CO able to handle large catalogs without a significant performance hit? I'm looking at more than 200k photos in a single catalog. Thanks for any insights.

Hi Aoma. We recommend using referenced catalogs when handling a large number of images, as it works only with previews. 
Thanks Marian. Sorry for the lack of info. Yes, I was referring to referenced catalogs. I came across some claims of  catalogs slowing down significantly with 
50k-100k images, so just wanted to make sure as my catalog size is more than 200k. 
Preferences such as preview size (David has just explained it), hardware acceleration, and of course the system itself affect the performance. There is no maximum 
of images for referenced catalogs. If you experience bad performance with large and referenced catalogs, we could take a look at your case and specific setup. 
Thank you Marian. I'll try to figure it out and get in touch if I need help. Thanks!

OK for the pictures, but where is the catalogue located ?<br> Hi Stevens. You choose the catalog location when creating it (Pictures folder in this case), you can always change the location by Finder/Explorer.

So, with a managed catalog, I could access the folder containg the images and rawfiles from another application without upsetting CaptureOne too much?
Hi Derek, What do you mean saying "from another application"? Just would love to understand your question better. 
Hi Helen, by "another application" I mean something like DaVinci Resolve, for converting image sequences to a video 
Basically, yeah, you should be able to reach out to the Originals folder where all the images in managed Catalog are stored. 
Ok, the folder name is useful to know, thank you :)

If I work the pics first with the COP iPad version, what would be the best way to import to my catalog? Import from Files is a recommended option, but you can learn more about import options here: https://support.captureone.com/hc/en-us/articles/5646097370397-
How-to-import-images

Can you convert a managed group to a referenced directory structure&nbsp; Yes, you can see how to do it here: https://support.captureone.com/hc/en-us/articles/360002669977-What-is-the-difference-between-a-referenced-and-a-managed-
Catalog-

Is face recognition part of CO23? If not is it planned to add this?

Hi Thomas, I hope to get your understanding, but we do not reveal any development plans :) You can sign up to our newsletter to be the first to know if any exciting 
things are coming. 

We currently have Smart Adjustments that kinda recognize the faces based on the referenced image, but I guess it's not exactly what you're searching for. Just in 
case you are interested: https://support.captureone.com/hc/en-us/articles/7129920998045-Smart-Adjustments 

is it possible to move many photos together? Hi Jeanmar. Yes, it is, you can move as many photos as you need or even folders. 
Thank you.

What's the main difference between a small referenced catalog and a Session? I usually use the sessions because they can be moved around independent.
Hi Bas. They are actually two completely different databases. If you are already used to working with sessions as you mentioned, when moving a session around 
you also move your files and everything is located inside the session folder (RAW files, exported files, etc). A referenced catalog is quite different, the original files 
are located independently, so moving the catalog around could be tricky, as it will lose the path to the files,  when moving a referenced catalog you only move the 
database, but not the files.

Can you eliminate duplicates Hi Van, Yes, you should be able to do that upon Import. Search for the relevant part of the info here:https://support.captureone.com/hc/en-us/articles/
360002492617-Importing-images-into-a-Catalog#h_01EC56GPKE640N43382955PSVE

Hello David,&nbsp; Albums are my favorite means of structing my vast collection of images. And it seems, 'Filter' and 'Search' still do not support questions like 
"show me the Albums, in which a selected image is contained" or "show me all images not yet associated to an Album" etc. That's the reason, why sometimes I had 
to do quite unnerving "manual" searches. Please, can you do something for me (and others, judging from support requests)?

Hi Günter. Please, submit a request through our support page, and we will forward your suggestion to our Product Team: https://support.captureone.com/hc/en-us/
requests/new?ticket_form_id=5001426573597

Can you make exclude? Yes, you can do that upon import. See the relevant part of the info here: https://support.captureone.com/hc/en-us/articles/360002492617-Importing-images-into-a-
Catalog#h_01EC56GPKE640N43382955PSVE

I am trying to import my main LR catalog consist of over 100k images ... images are organized by date YEAR/MONTH etc. and oldest ones are on classic hard drive 
and last year are on SSDs ... C1 is very very slow ... is there any way to work with large catalogs fast ?

Hi Jan! If you wish us to check the performance and dig deep into your situation, please, submit a request through our support page: https://
support.captureone.com/

So now Image from Origin point X has been moved into folders Y,Z etc. do edits applied in folder y update the image globally? or do you need to go to orgin X and 
edit here? Hi Lachlan! Once the image has been moved, you can edit it from whenever it is now. No need to move it back to the original location.

then how to "export" the collection of your best pics fro another special catalog such "portfolio best shots" ? Hi Thierry! You can create an album/smart album with your best images and export that album as a catalog.

Hello David, Albums are my favorite way of structuring my vast image collection. It seems filtering and searching do not support Album names. So I&nbsp; 
sometimes have to do rather painful manual searches to check, in which Albums a specific image is contained, or if in any at all.&nbsp;

Hi Günter, Yeah, that would be a great option to have. I'll make sure to move it forward. 
However, it would be super helpful if you could submit a support request mentioning your suggestion, so that we can have a proper record of that in our system. 

what is the diff. between project and session? Hi Erik! A project is a kind of User Collection only available in catalogs (in order to organize your files). A session is a completely different kind of database.
Can you place photos directly in a Project? Albums for the sake of themselves adds unnecessary clutter. Hi Adam! It is not possible to place images in projects, they must be always located inside albums.
Hope David will do a webinar focusing on keywords. Thank you :) Good point! I guess David has noticed your comment and will take that into consideration :)

Is there a recommendation for the max size of a catalog?<br>
Hi Klaus,  While there is no limit on the number of images you can put into a catalog, catalog performance depends on available system resources and read/write 
speeds. It’s really difficult to set a specific recommendation on number of images you should add to a catalog because there are so many different factors to take 
into account here (hardware, image size and location, preview size, amount of adjustments and number of collections/albums and lots more).

Question - I have a separate catalog for each year’s work. Each catalog has favorite images marked. Is there a way to make an “uber” catalog that spans ALL the 
years, and which contains only those favorite images? How would you do that? (Really hoping you can answer this! Thanks, Jim S.)

Hi Jim! You can create a smart album containing your favorite images in each catalog. Then, export those albums as catalogs and import all of them into a main 
one - the one that will contain only your favorite images. 

I have sessions that I will tag images with 4-5 stars for my favorites across sessions. What is the best way to copy these favorites into a separate "favorites" session, 
for later printing, for example.

Hi Paul! Sessions are completely different databases. If you are working with sessions, the way they manage the files is not the same. The first option that comes 
up to my mind is to import your sessions into a catalog and once you have all of them referenced inside the catalog, create a smart album containing your favorite 
images.

Hello. Is there a way of tag photos automatically? a plugin or something?
Depends on what you mean by "automatically". Like, recognizing persons and tagging those in keywords? 
REcognizing people would it be great, but I mean for, things, colors, objects, etc Google photos does a very good job on this. 
I don't think there's something in Capture One right now, but we can mark that as a feature request.

Best way to  move sessions into the catalog and retain all the adjustments? Hi Paul! You can actually import your sessions into a catalog: File > Import session. This way you'll have everything there. 
What if I want to also move that session's files as well. Say, from local folder, to folder on network drive that has catalog?

if I take my windows laptop with me on holiday and create a catalogue &amp; edit photo's with C1 while away, can I then transfer that catalogue to my iMac PC on 
returning home and all edits will carry across?

Hi Glyn! Yes, you can always move a catalog from one computer to another, doesn't matter that they are different OS (as far as they are compatible with the same 
version of Capture One). Please, check this article for further information: https://support.captureone.com/hc/en-us/articles/360003138037-How-to-move-a-Catalog- 

Can you clone a catalogue so you have one on your internal hard drive and another backup on an external hard drive? Hi James! Sure, that can be done. But that poses the problem of synchronizing the changes in them - if a catalog gets too large, it may take a lot of time to copy 
and overwrite the other catalog. I'd rather look at making backups (when closing Capture One) as often as possible.

David, you need to explain these images are not copied or moved , but referenced! Hi Jo! I don't remember the exact moment when you posted this comment, but I think that David meant that the images can be moved from one folder to another 
within Capture One even if they are referenced ones.

1



Are there Presets for Projects? Or can I duplicate Project with smart groups in it? Hey! There's not such presets now, but that makes a good feature request.

I use a desktop Mac Studio with a raid array where I store my C1 program and photos.  I have a macbook pro that I take on shoots with a SSD drive to store my 
photos and do some C1 processing.  When I get home I am unsure of how to merge the information and photos onto the mac Studio with the Raid array.  What files 
do I need to transfer while retaining my edits, etc.

Hi Robert, could you specify if you use a catalog or session? This will help us to find the best way around this. 
sessions 
You can have your images somewhere in a cloud-sync folder or a drive,  and access them from both sessions you work with - this will keep your image adjustments 
alongside the images themselves.

Can one photo be in more than one catalog? Sure, it can! Remember that we do not work with RAWs after you import your images, but rather the previews we generate from a RAW file.

What causes the number of images in the Folder to be smaller than the number in the All Collections?

Hi Jonathan! You mean the "All Images" counter, right? Only 22 files are referenced (in the folder), but some of the files are located inside the catalog, this is why 
the counter doesn't match. It counts all the files, no matter where they are located. 
Yes.  Sorry! 
I wasn't talking about his demo.  Talking about my catalog. 
Do you think there might be a problem with your catalog database so the counters are not matching? If so, we would need to dig deep into your specific case, feel 
free to submit a request on our support page: https://support.captureone.com/ 
I've submitted a request, because it's gotten much worse after the 16.0.2 update.  But for as long as I can recall there has been maybe a 10% difference between 
the All Images total and the Folders total.

When it says add to catalog does that still mean the photos stay where they are? Yes. Compare this with Copy into Catalog, which will move the images to the catalog structure.
Will you be reviewing image organization using sessions? Great idea! But that may need another webinar :)

What happens if I delete the files from the finder? Hi Petra! You can always right-click on the corresponding folder and select: Synchronize. Capture One will check if some files have been deleted and remove them 
from the catalog

Are you able to safely rename catalogs after making them? Say I accidentally made a misspelling
Better do that via Finder/File Explorer and then run that catalog from its location. This will update its name. 
Hi Landon! You can rename your catalog by Finder/Explorer. Please, check this article: https://support.captureone.com/hc/en-us/articles/360013934438-How-can-I-
rename-a-Session-or-a-Catalog-

So the photo files are moved on the hard drive? Hi Charles! If you drag the files from "In Catalog" to the drive or from one folder to another, they are "physically" moved on the hard drive.
hi, how can i change the order of a filename in yyyy-mm-dd You can use Batch Rename in the Image menu and select specific date tokens.

How do catalogs handle the same name of files? For instance if my camera’s counter resets after 9999. Hi! Those may be marked as duplicates as soon as you surpass the certain counter mark, but if you use different collections (Smart Albums/Albums), you may have 
the images stored that have their names overlapping.

So what is the best way to import photos? Hi Mildred! It depends on what kind of catalog you want to work with: referenced - choose Add to Catalog. Managed with the files inside the catalog ' choose Copy 
into Catalog

Which one is best? Managed or Referenced? Hi Flynt! It always depends on your workflow. If you need to handle a large number of files, referenced it is definitively the best option. David usually explains the 
benefits of a managed catalog at the end of the webinar if there is time.

where can i find more information about the difference between managed and referenced?
Hi Petra, you can find more info on that in this article: https://support.captureone.com/hc/en-us/articles/360002669977-What-is-the-difference-between-a-
referenced-and-a-managed-Catalog- 
Hi Petra! You can check this article that explains the difference between them: https://support.captureone.com/hc/en-us/articles/360002669977-What-is-the-
difference-between-a-referenced-and-a-managed-Catalog-

importing from memory card. Can you create the destination folder within C1? Or do you go to finder first? Hi William, yes, please check the Import To section in the Importer window. You can create the destination folder/collection there.

My camera is saving both RAW and JPEG files. Should I import both formats to a  C 1 Catalogue? Hi Kim! It depends on your workflow. For example: my camera saves both RAW and JPEG, because sometimes I want to edit the JPEG quickly or share them 
directly with my client,but I only import the RAW files into Capture One as I will be able to edit them with much more flexibility than the JPEG

Is it easier or safer to use a managed catalog for making back up files.
Hi Bob! Both managed and referenced options allow for creating a backup of your import (see Backup to section in the Importer). so it is up to you which one to 
use. 
but if the disk with the reference files fails don't I lose the images. I prefer to fill hard drives with copies of managed files. I think they offer more protection.

Can you automatically tag faces in photos, and is there a way to search on tagged subjects? Hi Stephanie! We do not have that feature in Capture One. You can always use the name of your models as keywords. 
Thanks!  Great suggestion.  However,  I was hoping for a less manual process since there are sometimes several subjects per photo and session/project.

Is it possible to create a projet with images from different folder without moving the picture in a special folder? Hi Serge!  Yes, I think you can use referenced catalog to have your images where they are physically.

archiving pictures (their forlder/s and adjustments, metadata, previews) - what would be the recommended way?

Hi Carsten, I think it depends on what you mean by "archiving" - could you elaborate on your use case? 
hello Victor. from internal to external drive in order to store that external drive somewhere and make space on the internal drive - and use these pictures at a later 
point in time (maybe another machine in some months/years time) 
Got it! You can copy the whole catalog if it's managed. If that's a referenced catalog, it is better to make it managed and do the same. See more here: https://
support.captureone.com/hc/en-us/articles/360002669977-What-is-the-difference-between-a-referenced-and-a-managed-Catalog- 
brilliant, thank you!

Why does Capture One create a "real folder" (visible to finder) upon creation but won't delete a folder when it is deleted (from within the catalog)? Seems like an odd 
asymmetry...

Hi Brad!  Do you mean that when deleting a folder from Capture One it still remains in your "Folders" structure? If so, it would be great if you could submit a request 
through our support page with the details: https://support.captureone.com/ 
Yes. It just seems odd that you can create a new folder from within Capture  One it is a "real folder (exists outside of the Capture One environment...and visible via 
using the finder) but deleting a folder from within Capture One just removes it from the catalog (and it is still sitting on your hard drive). 
Oh, okay, now I get what you meant. This is why that folder can contain other files (documents for example) that weren't referenced in the catalog. So when you 
delete a folder, Capture One only deletes it from the catalog folder structure, but not "physically" from your drive.

David showed one way to have a "portable" setup by moving files into the catalog temporarily.  But if you want to have your entire catalog and referenced library (on 
external SSD) to go with you on a laptop for a trip, can you copy the catalog file to the laptop, use the laptop with external SSD attached during the trip, and then 
move the catalog file back to the desk system when you return, with external SSD connected back to the desktop?

Hi Jonathan, sure! That can be done, but you have to make sure that the drive names are the same, so that catalog can remap those folders. 
Excellent.  So it's just the catalog file (package) that you need to copy back and forth between the desktop's and laptop's internal drive?  No other files?

Is there an instance where C1 "deletes" the file off the disk? Hi Grant! Right-click on the thumbnails of the files you want to delete and select Delete (Move to Catalog Trash), then you can empty the catalog trash and the files 
will be gone.

How do i move pictures from Lightroom to Capture One Hi Herbert! Please, take a look at this article, you'll find information about how to migrate from Lightroom to Capture One: https://support.captureone.com/hc/en-us/
articles/8808388225053-Importing-a-Lightroom-catalog

Are you able to safely rename catalogs after making them? Say I accidentally made a misspelling&nbsp; Hi Landon! Please, check this article: https://support.captureone.com/hc/en-us/articles/360013934438-How-can-I-rename-a-Session-or-a-Catalog-

How many Picture can contain a Katolog<br> Hi Masud, there's not a set limit to the number of images a catalog can handle, but it is a good practice to have theme-based catalogs organized by year, for 
instance, to make it easily manageable.

Is it possible to edit the photos in 'albums' under 'User Collections' in a different way? Hi Jacques, I guess so - could you clarify your use case? 
I want to perform different edits to photos for different purposes. For example, an album with color and an album with B&amp;W. (at te same pictures)

If you have saved pictures in Sessions folder, what is the best way to move them to a Catalogue Hi Marc, you can import session into a catalog, so it can be migrated with all its images and adjustments.
Is there a way to build a preset project and catalog structure or do I have to build everything over and over again? Same for sessions. Hi Amon! You can select File > Save as template, for both sessions and catalogs
If you're new to Capture One, and you're comparing the Learning Curve of Sessions vs. Catalogs, what are the percentage of learning for each? Or what is the time 
required for each?

Hi Tom! This is a personal choice, but sessions are way easier for beginners in my opinion. 
Thank you. This looks daunting! I'm going to start with Sessions for sure.

Can I share a collection between catalogues, so I can add images from diff catalogues to the same single collection?<br> Hi Tony! A collection is not a database itself (not possible to add files into it independently from a Catalog), you can export it as a catalog and then import that 
catalog into another one, but if you add new files, those files will be added to the current catalog you are working with

Can you re-label images or folders?
Hi Carolina, yes, you can re-label images, but not folders. Both can be renamed, though. 
Hi Carolina! Yes, you can, right-click on them and select Rename. In case of renaming files, you can batch rename them. 
Thank you

How can one separate clone variants? Hi there! You can always rate or tag each of them differently and then use smart albums
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How do you define a "small" catalog? Hi Gale, that could be around 500-1000 images. 
I have ~40,000 images and when traveling add about 5000 images per trip  is there a point at which it would be better to have more than one catalog?

How many referenced images can a Catalog handle? Hi Frank! There's no limit to the number of images a catalog can handle, but we recommend having catalogs organized by year or theme-based to make it easily 
manageable.

What happens if and when a file is deleted from the catalog or session?<br>
Hi Harry, you can either delete an image from a catalog or session, but first it is being put into the Trash folder of that document. Next thing is you can either delete 
the image from the catalog/session only or from the drive. 
Thank you.

How much does the size of the generated previews affect the size of the catalogue? Hi Walter, we create a preview file for each image, but since it is based on an original RAW file, it wouldn't be as big as that RAW, but would still make the catalog 
database use a large storage space.

Is there a strategy to work on the _same_ catalog from different computers? Or maybe a PC and a Mac?<br> Hi Andreas, this is not something we support, but the main workaround would be to work on the catalog on one computer, upload it to the cloud-sync drive and 
offload it on the other computer to continue working on it. Rinse, repeat :)

Is there a text version of this session to use for review? The text version of this webinar in our Help Centre.
Do catalogs now support the use of EIP files? I thought it was a "sessions only" thing. Hi Brad, yes, EIPs can be used in both sessions and catalogs now.
what happens when more than one monitor is connected? Hi Jörg-Mark! You can choose what you want to see on your second screen: browser or viewer. Go to Window > Workspace > Dual Monitor, you'll see two options

Special reason to use Montere4y instead of the latest Ventura? Jo, no, not really. We would recommend checking our requirements where you can see which version of Capture One supports this or that version of macOS. 
I was asking because I had to report a bug which came back, but I'm not sure if it's related to Ventura or C1 16, as C1 15 didn't show it anymore in it's last version.

will also the Q&A session be included in the videos? It will be available in the Help Centre under that specific webinar.

can you merge a lightroom catalog? Hi William! Yes you can, go t File > Import Catalog > Lightroom catalog 
Please, take a look at this article: https://support.captureone.com/hc/en-us/articles/8808388225053-Importing-a-Lightroom-catalog
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